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Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.
Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to
be carried out by suitably trained personnel in accordance with applicable code of practice.
If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be
impaired.
In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.
The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for
actual use based on the examples and diagrams.
No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software
described in this manual.
Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is
prohibited.
Throughout this manual, when necessary, we use notes to make you aware of safety considerations.
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal
injury or death, property damage, or economic loss.
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss.
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.
IMPORTANT Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for
Personal Protective Equipment (PPE).

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in
alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to
find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our
content while we implement these changes.
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Preface
About this manual

This information was developed to introduce you to the basics of FactoryTalk
eProcedure. This manual is one of a set of related manuals that describe
installing, programming, and operating the FactoryTalk® Batch system.
To review FactoryTalk Batch release notes and latest information regarding
product compatibility refer to the Product Compatibility and Download
Center (PCDC).

Document organization

The following subjects are presented in this document:
•
•
•
•
•
•

Legal Notices

eProcedure documentation
eProcedure components
eProcedure Server
Introduction to instruction-based phases
HTML-Based instruction files
Glossary

Rockwell Automation publishes legal notices, such as privacy policies, license
agreements, trademark disclosures, and other terms and conditions on the
Legal Notices page of the Rockwell Automation website.

End User License Agreement (EULA)
You can view the Rockwell Automation End User License Agreement (EULA)
by opening the license.rtf file located in your product's install folder.
The default location of this file is:
C:\Program Files (x86)\Common Files\Rockwell\license.rtf

Open Source Software Licenses
The software included in this product contains copyrighted software that is
licensed under one or more open-source licenses.
You can view a full list of all open-source software used in this product and
their corresponding licenses by opening the oss_license.txt file located your
product's OPENSOURCE folder on your hard drive. This file is divided into
these sections:
• Components
Includes the name of the open-source component, its version number,
and the type of license.
• Copyright Text
Includes the name of the open-source component, its version number,
and the copyright declaration.
Publication# BWEPRO-GR011E-EN-P - May 2022
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• Licenses
Includes the name of the license, the list of open-source components
citing the license, and the terms of the license.
The default location of this file is:
C:\Program Files (x86)\Common Files\Rockwell\Help\<product
name>\Release Notes\OPENSOURCE\oss_licenses.txt
You may obtain Corresponding Source code for open-source packages
included in this product from their respective project web site(s).
Alternatively, you may obtain complete Corresponding Source code by
contacting Rockwell Automation via the Contact form on the Rockwell
Automation website:
http://www.rockwellautomation.com/global/about-us/contact/contact.page.
Please include "Open Source" as part of the request text.
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Additional resources

Following is a comprehensive list of documentation for the FactoryTalk®
Batch products from Rockwell Automation.

Installation, Quick Start, and Getting Results Guides
Resource

Description

FactoryTalk Batch Components Installation and
Upgrade Guide
(BATCH-IN002)
FactoryTalk Batch View Quick Start Guide
(FTBVS-QS001)

Provides information and procedures for FactoryTalk Batch system installation. Includes
information for FactoryTalk Batch Material Manager, FactoryTalk Event Archiver, and
associated FactoryTalk Batch Client and Server components.
Provides information about using FactoryTalk Batch View to create, view, and command
control recipes, acknowledge prompts and signatures, view equipment phases and
diagnostic information, and view profile information.

FactoryTalk Batch View HMI Controls Quick Start
Guide
(BATCH-QS001D)

Provides a general overview of FactoryTalk Batch View HMI Controls.

FactoryTalk Batch eProcedure® Getting Results Guide Explains the basics of FactoryTalk Batch eProcedure.
(BWEPRO-GR011)

FactoryTalk Batch Getting Results Guide
(BATCH-GR011)

Introduces the basics of automated batch manufacturing and the FactoryTalk Batch
product components.

FactoryTalk Batch Material Manager Getting Results
Guide
(BWMTR-GR011)

Introduces the basics of FactoryTalk Batch Material Manager.

User Guides
Resource

Description

FactoryTalk Batch Material Editor User Guide
(BWMTR-UM001)

Provides access to information and procedural instructions required to configure
materials and the containers to hold them. The material data is stored in the material
database, which is used to create material-based recipes. This information is intended
as a reference for formulators.
Provides information on creating and maintaining an equipment database (area model).
The area model is available to all other FactoryTalk Batch programs, including the
Recipe Editor, Batch View, and Phase Simulator.
Describes the integration of the FactoryTalk Batch software with the Studio 5000 Logix
Designer® application and the Logix 5000™ family of controllers.
The integration simplifies the configuration and maintenance of the FactoryTalk Batch
automation system, provides better communication between the FactoryTalk Batch
Server and the Logix 5000 controller, and significantly reduces the programming effort
required to develop the phase logic code that resides in your Logix 5000 controller.
Provides instructions on using FactoryTalk Batch Recipe Editor to create and configure
master recipes for use in batch automation. The interface is based on IEC 61131-3
sequential function charts to organize recipes graphically into procedures, unit
procedures, operations, and phases. Build recipes using either the SFC format or a
table-based format.

FactoryTalk Batch Equipment Editor User Guide
(BATCH-UM004)
FactoryTalk Batch PhaseManager™ User Guide
(BATCHX-UM011)

FactoryTalk Batch Recipe Editor User Guide
(BATCH-UM006)

FactoryTalk Batch View HMI Controls User Manual
(FTBVS-UM003)

Provides details about using FactoryTalk Batch View HMI Controls to monitor and interact
with the production process within a FactoryTalk View SE Display Client.

Publication# BWEPRO-GR011E-EN-P - May 2022
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Description

FactoryTalk Batch View User Manual
(FTBVS-UM002)

Provides information and procedural instructions for using FactoryTalk Batch View in a
modern and intuitive portal into a comprehensive batching solution for effective
operations, leveraging its own web server using HTML5 technology to provide
connectivity into a FactoryTalk Batch Server.
Provides information and instructions specific to the FactoryTalk Event Archiver.
Intended for use by system administrators and production supervisors.

FactoryTalk Event Archiver User Guide
(BATCH-UM012)

Administrator Guides
Resource

Description

FactoryTalk Batch Administrator Guide
(BATCH-UM003)

Provides instructions for configuring security and services, and implementation and use
of components not typically accessed or used by batch operators, such as the
FactoryTalk Batch Server.
Provides procedures specific to FactoryTalk Batch eProcedure, such as implementing
security and configuring the user-defined area Active Server Page.
Included are instructions for tasks specific to FactoryTalk Batch, such as configuring
security and services to support FactoryTalk Batch eProcedure. Provides instructions on
the implementation and use of components not typically accessed or used by batch
operators, such as the FactoryTalk Batch Server.
Provides information and instructions specific to FactoryTalk Batch Material Manager.
Intended for use by system administrators and database administrators.

FactoryTalk Batch eProcedure Administrator Guide
(BWEPRO-UM011)

FactoryTalk Batch Material Manager Administrator
Guide
(BWEPRO-UM011)

Reference Guides
Resource

Description

FactoryTalk Batch Material Server API Technical
Reference
(BWMTR-RM001)
FactoryTalk Batch PCD Programming Reference
Manual
(BATCH-RM004)

Provides access to information regarding the interface between the FactoryTalk Batch
Material Server and the FactoryTalk Batch Material Editor and FactoryTalk Batch. It is
intended to be used as a reference information by custom interface developers.
Provides information and instructions about the FactoryTalk Batch PCD interface design.
It is intended to be used as a reference guide for PCD programmers.

FactoryTalk Batch Server API Reference Manual
(BATCH-RM003)

Provides information regarding the interface between the FactoryTalk Batch Server and
FactoryTalk Batch View — the Server Application Programming Interface (API). It is
intended to be used as a reference guide by custom interface developers.

FactoryTalk Batch System Files Reference Manual
(BATCH-RM005)

Provides the technical information for configuration and maintenance of a FactoryTalk
Batch system. It can be used as a reference information for implementation engineers
and system administrators.
FactoryTalk Batch eProcedure Instruction File Design Includes information about the building of instruction files for use in equipment database
Reference Manual
creation and recipe development. This information is intended to be used as a reference
by instruction file authors.
(BWEPRO-RM001)

View or download publications at
http://www.rockwellautomation.com/literature. To order paper copies of
technical documentation, contact your local Allen-Bradley® distributor or
sales representative.
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FactoryTalk eProcedure introduction
FactoryTalk® eProcedure® is part of the FactoryTalk Batch suite of software
components. As part of the FactoryTalk family, the FactoryTalk Batch
components increase overall plant efficiency by delivering the visibility,
control, and reporting needed to optimize manufacturing. Coordinated
execution reduces rework and improves product quality and consistency.
Real-time management of equipment utilization maximizes return on assets.
Implementing optimized recipes and procedures, increases plant capacity.
Using electronic, paperless operations improves productivity. Reduce
compliance costs by using electronic batch record implementation, paperless
manufacturing, and quality sign-offs. Lifting the compliance burden from
manufacturing reduces inventory levels and cycle times, which greatly
improves customer service.
The FactoryTalk Batch components ensure that plant floor operations are
optimized, giving quick returns on net assets. New product definitions are
deployed quickly into manufacturing. Production order information is
accurate. Business and plant-level control systems are tightly coordinated and
multiple sites operate as a team. Our completely open, configurable set of
products helps you define, manage, monitor, and control manufacturing at
local, remote, or contractor plants. Best of all, deploy the FactoryTalk Batch
components wherever needed (one at a time or all at once) to improve
productivity and plant control. The FactoryTalk Batch components include:
• FactoryTalk Batch
• FactoryTalk eProcedure
• FactoryTalk Batch Material Manager

What is eProcedure?

As one of the FactoryTalk Batch components, FactoryTalk eProcedure
manages, sequences and documents the execution of manual operations.
Automating batch sheets and standard operating procedures (SOPs) through
interactive web documents, eProcedure provides the control needed to rapidly
deploy new products into manufacturing and the data collection necessary to
achieve true plant floor to enterprise-wide integration. FactoryTalk
eProcedure provides the benefits of procedure automation without the
expense of equipment automation. The FactoryTalk Batch components
incorporate the principles of batch and procedure automation, an approach
defined by ISA’s S88.01 standard.
FactoryTalk eProcedure automation provides a means to automate the
execution of procedural logic associated with recipes, product grade changes,
Publication# BWEPRO-GR011E-EN-P - May 2022
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computer setup, and computer shutdown procedures. Operators perform the
actions on the equipment, but they are prompted and guided by eProcedure.
The procedure specifies the sequence and timing of actions that can be
manually performed or performed by automation equipment.
Typical procedures that can be automated using FactoryTalk eProcedure
include:
•
•
•
•

Benefits of eProcedure

Batch execution
Equipment startup and shutdown
Product changeover
Abnormal condition handling

FactoryTalk eProcedure reduces the amount of effort required to create and
maintain recipes, as well as minimizes the time required to collect and report
Batch data.
The following describes a typical recipe execution process, with and without
eProcedure:
Without eProcedure
A master recipe (a collection of SOPs) is maintained in
written form. The master recipe includes instructions
for the operator, places to enter data, and places for
any required signatures.

With eProcedure
A master recipe is created and maintained electronically with
the FactoryTalk Batch Recipe Editor. The master recipe
includes operator instructions, report data, and prompts for
required approvals.

When a batch needs to be run, the recipe is printed
and given to the operator, who reads the instructions,
manually sequences the process and enters the
required information on the printout.
When the batch is complete, the completed recipe
document is filed.

When a batch needs to be run, the operator adds a batch using
FactoryTalk Batch View, steps through the instructions, and
enters the required data into the system.
When the batch is complete, the electronic batch record
contains a complete record of the entire batch process.

The data can be manually entered into a database for The electronic batch record can be automatically transferred
recording and reporting purposes.
to any ODBC-compliant database using the FactoryTalk Event
Archiver.

FactoryTalk eProcedure can be implemented in a completely manual
manufacturing facility or in a partially automated facility. With eProcedure,
use all manual phases or a combination of manual and automated phases
within a single recipe. Regardless of the state of automation, the
implementation process is the same.
The FactoryTalk Batch Equipment Editor is used to define the process
equipment, both manual and automated. The modular approach in defining
equipment is as appropriate with manual facilities as it is in automated
facilities. As part of the configuration process, attach instruction files to each
of the manual equipment modules.
Instruction files are HTML files that include all of the required control steps
for a phase. Each control step can include textual instructions, embedded
parameter values, report fields for operator input, and submit buttons.
Control steps may also include any valid HTML component.
10
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Once the equipment is defined, and the instruction files are created, create
recipes in the same fashion as a completely automated facility.
FactoryTalk eProcedure allows the operator to create and command batches
from remote computers. With eProcedure, the operator no longer needs to
write processing information on a piece of paper for submission. The
operator enters the data directly into the computer where the data is stored
in an electronic batch record, which can later be downloaded into your
ODBC-compliant database.

FactoryTalk Batch
Components

FactoryTalk Batch comes with several components that interact with each
other to design, create, configure and run batch recipes.

FactoryTalk Batch Server

The FactoryTalk Batch Server is the engine that runs FactoryTalk Batch. It is
the component that controls system information, phases and recipes. The
server allows integration with process-connected devices (PCDs) and
third-party software packages. Prior to opening FactoryTalk Batch View, the
FactoryTalk Batch Server must be running and remain active during all batch
functions.
The FactoryTalk Batch Server operates as a Windows service, which means
that the FactoryTalk Batch Server can be configured to start automatically and
that control of the FactoryTalk Batch Server can be given to the Windows
Service Manager. Because the FactoryTalk Batch Server runs as a service, it
does not require an operator to log on to run. Therefore, logging on or off
Windows during operation does not disrupt the performance of the
FactoryTalk Batch Server.

FactoryTalk Batch View

Use FactoryTalk® Batch View to initiate and control the batch process. A batch
is a running control recipe. The material produced by a single execution of a
recipe is also considered a batch.
• Use Batches to create, view, and command a control recipe, observe
the execution of a single recipe, and bind units for class-based recipes.
Once a control recipe is created, it remains in the Batches list until it is
removed or until the FactoryTalk Batch Server is restarted with a cold
boot. A graphical representation of a running batch and its associated
data is displayed.
• Use Prompts to alert operators to value requests for parameters, unit
binding, material binding, and signatures or manual instructions. A
control recipe cannot complete execution until the operator provides
the requested information. In most cases, pending requests for
information (value prompts, signatures, or manual instructions) are
not acknowledged until a user either provides the information or stops
or aborts the control recipe.
Publication# BWEPRO-GR011E-EN-P - May 2022
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• Value prompts alert operators to requests for parameter values, unit
binding, and material phase/container binding.
• Signatures are requests for signoffs that require user permissions
and optional comments. When a signature is generated against a
control recipe, acknowledge the signature by completing the
associated signoffs. The requested user information in a signature
is determined by the signature template defined in the area model.
• Instructions are individual steps of a manually executed phase. As a
batch executes, the instruction for each active step appears.
Instructions execute in the order specified within the master recipe.
• Use Equipment for an equipment-centric view of the defined area
model. There are three levels of equipment: process cell, unit, and
phase.
• Use Diagnostics to view server and service status, server performance,
server statistics, arbitration, and journals.
• Use Profile to change the default language, view assigned groups,
enable or disable the minimal view, and view authorization settings
For more information on using these features, see FactoryTalk Batch View
Help.

FactoryTalk Batch Recipe
Editor

12

The FactoryTalk Batch Recipe Editor is used to graphically create and
configure recipes.
• The interface is based on IEC 61131-3 sequential function charts (SFC)
that graphically organizes recipes into procedures, unit procedures,
operations and phases along with any applicable comments.
• In addition to the SFC view, the FactoryTalk Batch Recipe Editor offers
a table view. Table-based recipes provide a mechanism for creating
simple recipes that do not require a complex recipe structure or
elaborate transition expressions. Additionally, you can view
table-based recipes and edit all recipe parameters without having to
navigate between steps.
• The FactoryTalk Batch Recipe Editor allows you to specify sequences of
phases. The actual phase logic must be configured in the
process-connected device (PCD) while the interface to the PCD must
be configured in the FactoryTalk Batch Equipment Editor.
• Recipe reports can be generated in SFC and/or descriptive format.
• If Recipe Approvals are enabled in the underlying area model, approval
signoffs are executed in the FactoryTalk Batch Recipe Editor.
• When Recipe Version Control is enabled, a version of a recipe (a
read-only, numbered snapshot of a recipe) can be saved and protected
from further editing. New work-in-progress (WIP) copies of a version
allow the recipe author to continue to make changes and updates to a
recipe. When a versioned recipe no longer matches the underlying area
model, or references a deleted or non-existent sub-recipe, it is marked
as obsolete.
Publication# BWEPRO-GR011E-EN-P - May 2022
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The FactoryTalk Batch Equipment Editor is a graphical interface through
which a database of process equipment is defined and maintained (an area
model).
• Components defined in the FactoryTalk Batch Equipment Editor are
used to interface with process-connected devices (PCDs) in the facility.
During recipe configuration, the area model provides a list of available
units and phase classes.
• Configure phases and commands to trigger an electronic signature
request when a report or recipe parameter is out of range (parameter
deviation), or when specific commands are executed on a batch (such
as Abort Batch or Active Step Change).
• During recipe verification, the area model confirms that the
designated equipment is capable of executing the procedures.
• During recipe execution, resource arbitration functions use the area
model to allocate equipment based on recipe and operator requests.
• The area model is available to all other FactoryTalk Batch applications.
In addition to the area model, the FactoryTalk Batch Equipment Editor allows
configuration of the following:
•
•
•
•
•
•
•

Communication functions
Electronic signatures
Enumeration sets
Data servers
Recipe approvals
Recipe version control
FactoryTalk Event Archiver functions

FactoryTalk Event Archiver

The FactoryTalk Event Archiver’s purpose is to translate the FactoryTalk Batch
tab-delimited ASCII electronic batch record files to a user-specified file type.
These electronic batch record files are maintained separately for each batch
created and viewed with a word processor or spreadsheet. Many plants have
standardized on one of the many commercially available Relational Database
Management System (RDBMS) software packages. We recommend using a
high-performance database, such as SQL Server, due to their better
robustness and performance. The Archiver collects data from each electronic
batch record file and stores it in the specified RDBMS database format.

FactoryTalk Batch Network
Editor

The FactoryTalk Batch Network Editor is a utility that indicates where other
FactoryTalk Batch and FactoryTalk Batch Material servers are located on the
network. This network configuration allows for ease of integration with other
FactoryTalk Batch components and simplifies the process of reconfiguring a
multi-computer system. If FactoryTalk Batch Material Manager is also
Publication# BWEPRO-GR011E-EN-P - May 2022
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installed the FactoryTalk Batch Network Editor is also used to indicate the
location of the material database.

FactoryTalk eProcedure
Server

The FactoryTalk eProcedure Server provides the services to the FactoryTalk
Batch Server to enable the use of HTML instruction files. Prior to connecting
a client to FactoryTalk eProcedure, FactoryTalk eProcedure Server must be
running and remain active during all batch functions.

FactoryTalk Batch Material
Manager

FactoryTalk Batch Material Manager is used to track material consumption in
batch recipes. It consists of two components: Material Server and Material
Editor.
The Material Editor provides an interface to help you create the material
database, which consists of material, lot, sublot, container, and storage
location data. The Material Server provides the communication between the
material database and the FactoryTalk Batch Server. During a batch run,
information about available containers is presented to the operator for
binding decisions. Binding is the process of mapping steps within a control
recipe to actual equipment in a plant. After a batch is run, quantities
consumed or distributed are updated in the material database for use in
inventory tracking.
The Material Server consists of a group of components that work together to
service various applications. The primary applications that the Material Server
services are the Material Editor, FactoryTalk Batch Server, FactoryTalk Batch
Recipe Editor, and FactoryTalk Batch Equipment Editor. Any third-party
application can also use custom solutions based on the exposed Material
Object Model (MOM).

14
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For ease of understanding, and for tutorial purposes, this guide refers to
configuring and using the sample files installed with FactoryTalk Batch. The
SampleDemo folders contain complete area models and recipes for a
simulated plant. Before running the demonstrations, you must add a
FactoryTalk Security user, configure the FactoryTalk Batch Server to
recognize the required project directories, select the initialization path and
file name, and then start the FactoryTalk Batch Server, the FactoryTalk
eProcedure Server, and the FactoryTalk Batch Phase Simulator.
Tip:

This guide outlines the configuration and use of the SampleDemo demonstration files. It
is recommended that you follow the directions for using this demonstration step by
step.

The FactoryTalk eProcedure Server provides the services to the FactoryTalk
Batch Server to enable the use of HTML instruction files. Communication
from FactoryTalk Batch View to the eProcedure Server uses HTTPS.
FactoryTalk eProcedure uses OLE for Process Control (OPC) for
communications between the eProcedure Server and the FactoryTalk Batch
Server.
The eProcedure Server coordinates the following functions:
• Provides the services to the FactoryTalk Batch Server to enable the use
of HTML instruction files.
• Formats parameters and report parameters from material-based
recipes into instruction files.
This section assumes that the FactoryTalk eProcedure Server, the FactoryTalk
Batch Server, and FactoryTalk Batch View have been installed and configured.
(See the FactoryTalk Batch Components Upgrade and Installation Guide for more
information.)

Set up sample
demonstrations

The installation process placed the SampleDemo1 and SampleDemo2 folders in
the BATCHCTL share on your hard drive. Within each of these SampleDemo
folders are four subfolders that contain the files for the area model.

To set up sample demonstrations:
1. Add a FactoryTalk Security user.
2. Configure the FactoryTalk Batch Server to locate the area model.
3. Verify the recipes in the area model.

Publication# BWEPRO-GR011E-EN-P - May 2022
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Add sample FactoryTalk
Security users

For the sample demonstrations file, create FactoryTalk user accounts for an
operator and an engineer. Create these user accounts in the FactoryTalk
Directory.

To add sample FactoryTalk Security users:
1. Select Start > Rockwell Software > FactoryTalk Administration
Console. The Select FactoryTalk Directory dialog box opens.
IMPORTANT Administrator privileges are required to perform this procedure.

2. Select Network to add this user account to the FactoryTalk Network
Directory, and select OK.
3. If not already logged on to the FactoryTalk Network Directory, the Log
On to FactoryTalk dialog box opens. In User name, type the user name
for the Administrator that was configured when the FactoryTalk
Services Platform was installed.

4. In Password, type the password for the Administrator.
5. Verify the Directory and select OK. The FactoryTalk Administration
Console window opens and displays the specified FactoryTalk
Directory.
6. Expand Users and Groups.

16
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7. Right-click the Users folder, and select New > User to create a new
FactoryTalk Security user account in FactoryTalk Directory.

8. The New User dialog box opens and displays the General tab. In the
User name box, type OPER.

9. In Full name, type Operator.
10. In Password, type password, and confirm it by re-entering password
in the Confirm Password box.
11. Select Create.
12. Repeat steps 7-11, but this time in the User Name field, enter ENG and
in the Full Name field, enter Engineer.
13. Keep the FactoryTalk Administration Console open to configure
permissions for these FactoryTalk Security users in the next exercise.

Configure sample
permissions for FactoryTalk
Security users

After creating the FactoryTalk security users, set up access modes for each
FactoryTalk Batch component to specify which users are permitted to view or
perform actions. Configure security settings in the FactoryTalk
Administration Console. To tighten security in the client, remove the All
Users group from the Full Edit policy setting.

Publication# BWEPRO-GR011E-EN-P - May 2022

17

Chapter 2

The eProcedure Server

To configure sample permissions for FactoryTalk Security users:
1. In the FactoryTalk Administration Console Explorer pane, navigate to
System > Policies > Product Policies > Batch > Equipment Editor >
Access Modes.
2. Right-click Access Modes, and then select Properties. The Access
Modes Properties dialog box opens.

3. In the Full Edit row, select the Configure Security browse button. The
Configure Securable Action dialog box opens.
4. Select Add. The Select User and Computer dialog box opens.
5. In the Filter Users box, select Show All.

18
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6. In Users, select ENG.

7. Select OK. The Configure Securable Action dialog box is updated,
showing ENG in the list of Users with the Allow checkbox selected.

8. Select OK to close the Configure Securable Action dialog box.
9. In the Access Modes Properties dialog box, select View Only.
10. In the View Only row, select the Configure Security browse button.
The Configure Securable Action dialog box opens.
11. Select Add. The Select User and Computer dialog box opens.
12. In the Filter Users box, select Show All.
13. In Users, select OPER.
14. Select OK. The Configure Securable Action dialog box is updated,
showing OPER in the list of Users with the Allow checkbox selected.
15. Select OK to close the Configure Securable Action dialog box.
16. Select OK to close the Access Modes Properties dialog box.
Publication# BWEPRO-GR011E-EN-P - May 2022
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See the FactoryTalk Batch Administrator Guide for more information on security.

Configure the sample
FactoryTalk Batch Server

To set up the sample demonstrations, configure the FactoryTalk Batch Server
to locate the folders that contain the demonstration files and to the \Restart
and bin folders where the FactoryTalk Batch Server writes data upon system
failure. Configure the FactoryTalk Batch Server in the FactoryTalk Batch
Equipment Editor.

To configure the sample FactoryTalk Batch Server:
1. Select Start > Rockwell Software > Equipment Editor. The FactoryTalk
Batch Equipment Editor opens (log on to FactoryTalk if prompted).
IMPORTANT Administrator privileges are required to perform this procedure.

2. Select Options > Server Options. The Server Options dialog box opens
to the Project Settings tab.

3. In the Project Directories area, select the Primary Journal browse
button. The Select Directory dialog box opens.
4. From the Look in list, select the SampleDemo1\Journals folder, and
then select Open.
5. Select the Error Logging browse button. The Select Directory dialog
box opens.
6. From the Look in list, select the SampleDemo1\Logs folder, and then
select Open.
7. Click the Instructions browse button. The Select Directory dialog box
opens.
IMPORTANT In order for the eProcedure Server to start, you must define the instruction path
and an instruction file for each instruction-based phase in the area model. (See
the FactoryTalk Batch Equipment Editor User Guide for instructions on defining
instruction-based phases.)

8. Select the Equipment Database browse button. The Select Equipment
Database dialog box opens.
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9. From the Look in list, open the SampleDemo1\ Recipes folder, select
the ice_cream1.cfg file, and then select Open.
10. In the Store Recipes Using area, select Binary Files, and then select the
Recipe Directory browse button. The Select Directory dialog box
opens.
11. From the Look in list, select the SampleDemo1\Recipes folder, and
then select Open.
12. Select the Restart Control tab.

13. Select the Primary Path browse button. The Select Directory dialog
box opens.
14. From the Look in list, select the SampleDemo1\Restart folder, and
then select Open.
15. Select the Secondary Path browse button. The Select Directory dialog
box opens.
16. From the Look in list, select the Bin folder.
17. Select the Batch Reporting tab. Leave Never (No Queue) as the default
reporting application.

18. Select OK to close the Server Options dialog box.
19. Select File >Exit to exit the FactoryTalk Batch Equipment Editor.
Tip: These steps set up the FactoryTalk Batch Server to run the tutorial steps in this manual.
There are many other settings to consider when setting up the FactoryTalk Batch system. (See
the FactoryTalk Batch Administrator Guide for more information on the Server Options
dialog box.)

Rebuild the recipe directory

To run the demonstration recipes, rebuild the recipe directory and verify the
recipes in the area model using the FactoryTalk Batch Recipe Editor.
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To rebuild the recipe directory:
1. Select Start, point to All Programs > Rockwell Software > FactoryTalk
Batch Suite > FactoryTalk Batch, and then select Recipe Editor. The
Recipe Editor reads the area model.
2. Log on to FactoryTalk if prompted.
IMPORTANT Administrator privileges are required to perform this procedure.

If a message to verify the recipes displays, select Cancel.
3. Select File > Rebuild Recipe Directory. When the rebuild completed,
select OK, and then select Yes to verify the recipes.
4. When the recipe verification completes, select Accept to save the
recipes, and then select Close.
5. Select File > Exit to exit the FactoryTalk Batch Recipe Editor.

Start the Batch and
eProcedure Servers

The FactoryTalk Batch and FactoryTalk eProcedure Servers may start
automatically when the computer starts. By default the FactoryTalk Batch
Server starts in production mode. If FactoryTalk Batch is not activated, run
the tutorial in demo mode. While in demo mode, the FactoryTalk Batch Server
runs for a two-hour period and then stops.
Tip:

The FactoryTalk Batch Server does not start in production mode without activation. (See the
Activate Rockwell Software Products insert included with the software CD.)

IMPORTANT: If you are using Windows Server to host your Batch and eProcedure Server, ensure that the Internet
Explorer Enhanced Security Configuration setting on the server has been turned off.
For instructions, see the Microsoft Web site.

To start the Batch and e Procedure Servers:
1. Select Start, point to All Programs > Rockwell Software > FactoryTalk
Batch Suite > FactoryTalk Batch, and then select Batch Service
Manager. The FactoryTalk Batch Service Manager opens.
IMPORTANT Administrator privileges are required to perform this procedure.

2. If the FactoryTalk Batch Server is not already listed in the Service box,
select it from the list.
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3. If the FactoryTalk Batch Server is running, select Stop.

4. If the name of the computer where the FactoryTalk Batch Server is
installed does not display in the Computer box, select the Select
Computer button. The Select Computer dialog box opens.
5. In the Enter the object name to select area, type the name of the
computer where the Batch Server is installed (or select Advanced to
search for a computer). Select OK.
Tip:

The FactoryTalk Batch Service Manager must communicate with the Windows Service Manager
of the selected computer to determine what services are available. There may be a noticeable
delay as communications are established. If the Service Manager cannot communicate with the
Windows Service Manager of the selected computer, a message displays.

6. From the Service list, select FactoryTalk Batch Server.
Tip:

If No Batch Services displays in the list, the FactoryTalk Batch Server is not installed on the
selected computer. See the FactoryTalk Batch Components Installation and Upgrade Guide
for instructions.

7. To start the FactoryTalk Batch Server in Demo mode, select Allow
Demo Mode.
8. Select the method to use for booting the server.
Cold Boot

Restarts the FactoryTalk Batch Server in a cold state. All journal data or recipe
content is erased upon startup.

Warm Boot

Restarts the FactoryTalk Batch Server, restoring the set of batches that were on
the batch list when the server previously terminated.
Restarts the FactoryTalk Batch Server only if it is able to restore all of the batches
to the batch list.

Warm All Boot

9. Select Start/Continue. The Service State area changes from STOPPED
to START PENDING. After a few moments, RUNNING displays and
the light changes to green.
The FactoryTalk Batch Phase Simulator may start automatically and
open a window. If so, minimize the window.
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10. Select the eProcedure Server from the Service list.

11. Select the method to use for booting the server.
Cold Boot - checked

Restarts the FactoryTalk eProcedure Server in a cold state. All control steps, plus all
signatures and previously-entered values associated with the control step due to
parameter deviation or cancelled step verification signatures, are removed.

Cold Boot unchecked

Restarts the FactoryTalk eProcedure Server, restoring the control steps that were active
when the server previously terminated (the control step is restarted with a new
reactivation number).

(See Effects of warm boot on control step on page 26 for more information.)

12. Select Start/Continue. The eProcedure Server starts running.
13. Click Close to close the FactoryTalk Batch Service Manager.
Tip:

Start the sample
FactoryTalk Batch Phase
Simulator

If conversation becomes LOST while running in Demo mode, make sure that the Simulator is
running and try starting the server(s) again.

FactoryTalk Batch comes with a phase logic simulation program, referred to
as the FactoryTalk Batch Phase Simulator used to simulate the batch process
without connecting to a PCD. The Phase Simulator imitates the functionality
of a data server and can communicate with the FactoryTalk Batch Server
using OPC communication protocol. The Phase Simulator is a powerful tool
for testing, experimentation and demonstration purposes. In this guide, run
the sample demonstration using the Phase Simulator.
Tip: If the Phase Simulator is required and OPC protocol is used for communications, the FactoryTalk
Batch Server automatically starts the Phase Simulator. Check the Windows taskbar to see if the Phase
Simulator is started.

To run the sample demonstration correctly, open the ice_cream1.sim file in
the Phase Simulator.

To start the sample FactoryTalk Batch Phase Simulator:
1. If the Phase Simulator is already running, maximize it from the
Windows taskbar. If the Phase Simulator is not running, select Start >
Rockwell Software > Simulator. The FactoryTalk Batch Phase
Simulator opens.
IMPORTANT Administrator privileges are required to perform this procedure.
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2. Select File > Open. The Open Simulator Configuration File dialog box
opens.
3. From the Look in list, open the Program Files > Rockwell Software >
Batch > SampleDemo1 > Recipes folder. Select the ice_cream1.sim file,
and then select Open.
4. Minimize the FactoryTalk Batch Phase Simulator window.

Open the sample
demonstration in the
FactoryTalk Batch Phase
Simulator

To open the sample demonstration, you must open the ice_cream1.sim file in
the Phase Simulator.

To open the sample demonstration in the FactoryTalk Batch Phase
Simulator:
1. From the File menu, select Open. The Open Simulator Configuration
File dialog box opens.
2. From the Look in list, open the Program Files (x86)\Rockwell
Software\Batch\SampleDemo1\Recipes folder. Select the
ice_cream1.sim file, and then select Open.
3. Minimize the Phase Simulator window.

Verify PCD communications

Use the following instructions to verify PCD communications.

To verify PCD communications:
1. Select Start, point to All Programs > Rockwell Software > FactoryTalk
Batch Suite > FactoryTalk Batch, and then select Batch Service
Manager. The FactoryTalk Batch Service Manager opens.
IMPORTANT Administrator privileges are required to perform this procedure.

2. Make sure FactoryTalk Batch Server is selected in the Service box.
3. Select Server Statistics. The FactoryTalk Batch Server Statistics dialog
box opens.
4. Select the PCD Communications tab. The Data Server Status area
displays the status of the conversation with the OPC_SIM data server
(Phase Simulator), which should be PHASES GOOD, and the
INSTRUCTIONBASEDSERVER, which should be INSTRUCTIONS
GOOD.
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5. In the Tag Verify area, select Start to begin the verify process. The tag
verification process takes several minutes.
6. When the Status box shows COMPLETED, select OK to close the
FactoryTalk Batch Server Statistics dialog box.

Effects of warm boot on
control steps

A warm restart (boot) of the eProcedure Server has the following effects on
control steps:

Summary

In this chapter, you:

• Reactivated steps are not active after a warm boot. Instead, the
previously active control step is active. The left column in Past
instructions contains the usual information (the reactivation number
is remembered). The middle column displays Reactivated Control Step
Terminated by eProcedure Server shutting down and the right
column has a check mark. An InstructionComplete event record
containing the step’s HTML is created. In addition, a ControlStepStop
event record is added. These control steps are not eligible for
reactivation.
• Control steps that were active during a warm boot of the eProcedure
Server are still active when the server starts again, but the control step
is restarted with a new reactivation number. All signatures and
previously-entered values associated with the control step due to
parameter deviation or canceled step verification signatures are
removed. A Past control step is added, which states Control Step
Terminated by eProcedure Server shutting down.

• Set up the FactoryTalk Batch Server to run the sample demonstration
• Started the FactoryTalk Batch and eProcedure Servers in demo mode
• Opened the .sim file in the Phase Simulator to run the sample
demonstration
• Verified PCD communications status
This chapter provided a brief overview of the capabilities of the FactoryTalk
Batch and eProcedure Servers. (See the FactoryTalk Batch Administrator Guide
for more information about the FactoryTalk Batch Server. See the FactoryTalk
eProcedure Administrator Guide for more information about the eProcedure
Server.)
Tip:
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The rest of this document is designed to give you a tour through eProcedure
using the sample demonstration. Follow the step-by-step instructions to learn
how to run instruction-based recipes using eProcedure.
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An instruction-based phase is a phase that is linked to an instruction file —
when the phase executes, the contents of the instruction file display in a
browser window.

Create instruction-based
phases

An instruction-based phase consists of an instruction file that is assigned to
the phase.

To create instruction-based phases:
1. Create the instruction file.
2. Assign the instruction file to a phase

Create an instruction file

An instruction file contains the series of steps, such as operation instructions
and operator feedback entries that present to the operator though Internet
Explorer. All the actions performed are recorded in the Event Journal for a
permanent record of the process. For example, you can add a step in the
instruction file that prompts the operator to verify a temperature; the
temperature value and the approval indication appears in the Event Journal.
For this exercise you will use Microsoft® Notepad to view an existing
HTML-based web page that uses standard HTML tags and custom HTML tags
designed for use with the eProcedure Server. To understand how the
instructions are written, see Custom tags.

To create an instruction file:
1. Open Notepad.
2. From the File menu, select Open. Navigate to C:\Program Files\Rockwell
Software\Batch\SampleDemo1\instructions (if you did not use the default
install path, navigate to the correct location).
3. Select add_egg_1.htm and select Open.
4. Select File > Save As, and save the htm file with the name
add_egg_demo.htm.
The file consists of several short forms, designated by the <form> and
</form> HTML tags.
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5. Locate the text highlighted in the first form in the following
illustration:

6. The highlighted line tells the eProcedure client to:
Prepare <sop>UNIT</sop> for delivery of <sop>ADD_AMOUNT</sop>
KG of Egg.
This line appears as the first step in the manual phase and at run time
replaces <sop>ADD_AMOUNT</sop> with the actual amount to add to
the recipe.
7. The code and text in the second form tells the eProcedure client to:
Begin charging <sop>ADD_AMOUNT</sop> KG of Egg into
<sop>UNIT</sop>.
Press OK when complete.
8. Locate the third form in the file. Change the word Egg to Egg_Demo,
as shown here:

Note that this form also contains a text box (<INPUT TYPE="TEXT"
SIZE="20" NAME="AMOUNT_ADDED">). At run time the operator
enters the amount of Egg that was added to the recipe.
9. Select File > Save. Be sure to save the file in the
SampleDemo1/Instructions folder for the project.
The full path is
c:\Program Files\Rockwell Software\Batch\SampleDemo1\Instructions or
\\computername\BATCHCTL\SampleDemo1\Instructions if you are
developing on a remote computer.
28

Publication# BWEPRO-GR011E-EN-P - May 2022

Chapter 3

Introduction to instruction-based phases

10. Close the file and exit Notepad.

Custom tags

The instructions are written using plain text. To obtain specific server-related
information, use the custom tags shown in this table.
Data Type

HTML Code

Display Value

Batch Data

<sop>BatchID</sop>

Batch ID of the running recipe

<sop>Unit</sop>

Unit name for the current phase

<sop>Cell</sop>

Process cell

<sop>Phase</sop>
<sop>parameter.Name</sop>

Current phase name
Parameter name

<sop>parameter.EU</sop>

Parameter engineering units

<sop>parameter.Min</sop>

Parameter minimum allowed value

<sop>parameter.Max</sop>

Parameter maximum allowed value

<sop>parameter.LowLowLowLimit</sop>

Parameter Low-Low-Low limit

<sop>parameter.LowLowLimit</sop>

Parameter Low-Low limit

<sop>parameter.LowLimit</sop>

Parameter Low limit

<sop>parameter.HighLimit</sop>

Parameter High limit

<sop>parameter.HighHighLimit</sop>

Parameter High-High limit

<sop>parameter.HighHighHighLimit</sop>

Parameter High-High-High limit

<sop>parameter.Value</sop>
<sop>parameter.Default</sop>
<sop>report.Name</sop>

Parameter value
Parameter default value
Report Name

<sop>report.EU</sop>

Report engineering units

<sop>report.Value</sop>

Report value

<sop>report.LowLimit</sop>
<sop>report.LowLowLimit</sop>
<sop>report.LowLowLowLimit</sop>
<sop>report.HighLimit</sop>
sop>report.HighHighLimit</sop>
<sop>report.HighHighHighLimit</sop>
<sop>VERIFICATIONSIG=SignatureTemplate</sop>

Report low limit
Report low-low limit
Report low-low-low limit
Report high limit
Report high-high limit
Report high-high-high limit
Signature template to be used for a
verification signature

Parameter Data

Parameter Data
(continued)

Report Data

Electronic
Signatures

Assign an instruction file to
a phase

After you create the instruction file you must assign it to a phase in the
FactoryTalk Batch Equipment Editor. When the phase is activated in the
recipe, the FactoryTalk Batch Server runs the instruction file.

To assign an instruction file to a phase:
1. Start the FactoryTalk Batch Equipment Editor and open the
ice_cream1ep.cfg area model.
2. Double-click the South Parlor process cell.
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3. Double-click SP_MIXER1.
4. Double-click SP_ADD_EGG_M1. The Edit Equipment Module dialog
box opens to the General tab.

The Instruction File box indicates that an instruction file is already
assigned to this phase. You will replace it with the instruction file that
you just created.
5. Select the Browse button next to the Instruction File box. The
Instruction Selection box opens to display the HTML code within the
file.

6. Select add_egg_demo.htm, and then select OK twice.
7. Save the area model and exit the FactoryTalk Batch Equipment Editor.
Tip:

Include a step verification
signature template

Since you made changes to the area model, you need to verify and deploy the area model
at this point if you want to run any batches.

You can require a step verification signature using a specific signature
template for a control step. You can add a step verification signature to any
control step that must be signed off before recipe execution can continue. The
verification signature template is defined in the FactoryTalk Batch Equipment
Editor. The signature must be completed before recipe execution can
continue.

To include a step verification signature template:
1. Open or create a blank instruction file. (See Create an instruction file
for more information.)
2. Place your cursor at the beginning of the first cell.
30
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3. Using the correct naming conventions, enter the tagged data item.
Example:
<sop>VERIFICATIONSIG=SignatureTemplate</sop>
where SignatureTemplate is the name of the desired template.

Summary

In this chapter, you:
• Created an instruction file using Microsoft Word and FrontPage.
• Assigned the instruction file to a phase using the FactoryTalk Batch
Equipment Editor.
This chapter provided a brief overview of instruction-based phases. (See the
FactoryTalk Batch Equipment Editor User Guide for more information on
instruction-based phases.)
For further information about designing FactoryTalk eProcedure instruction
files, see the FactoryTalk Batch eProcedure Instruction File Design Reference Manual
(BWEPRO-RM001).
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Acquiring
Acquiring is a possible state of the Firing attribute of a transition.
When the transition is in the Acquiring state, it has made non-binding
related arbitration requests for resources needed by one or more steps
following the transition.

Activation file
A text file that contains all of the activation information that is
required to license a software product and allow it to properly
function. While the file is simply plain text, the contents of the file are
protected by a signature.

Binding
Binding is the process of mapping steps within a control recipe to
actual equipment in a plant.

Binding (in transitions)
Binding is a possible state of the Firing attribute of a transition. When
the transition is in the Binding state, it is in the process of attempting
to bind one or more of the steps following the transition. The binding
process may involve the generation of binding prompts and/or the
generation of arbitration requests.

Comm Err
Comm Err is a possible state of the Firing attribute of a transition.
When the transition is in the Comm Err state, a communications error
with phase logic has been detected while the transition was in the
Stopping/Resetting/Pending states of the firing process. The
transition has rolled back to the beginning of the
Stopping/Resetting/Pending process and is awaiting good
communications and a RESTART command before re-initiating the
firing process.
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Comment descriptor
In a signature dialog, the text in parentheses that indicates if the
comment field is optional, required, or not allowed.

Committed
Committed is a possible state of the Firing attribute of a transition.
When the transition is in the Committed state, it has committed to the
firing process, but is not in the process of firing because either the
transition is in the HELD state or the parent procedure is in MANUAL
mode.

Control step
One instruction in an eProcedure phase. An eProcedure phase consists
of one or more control steps. Also referred to as step, eProcedure step,
or instruction step.

Control step reactivation
Making a completed control step in an eProcedure phase active again
so that mistakenly entered values can be re-entered.

Dedicated resource
A resource used by only one step at a time inside a recipe structure.

Deviation event
A deviation event is a probable new event type for the event journals
that records the deviation information.

Diagnostics client
System components that retrieve diagnostic information from
FactoryTalk Diagnostics. Clients can be FactoryTalk system elements
or applications.

Diagnostics destinations
Storage or destinations of diagnostics messages such as the
FactoryTalk Diagnostics native store, RSMACC, etc. The FactoryTalk
Diagnostics framework was designed to be extensible to allow
additional message destinations to be defined and added to the
system.
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Diagnostics native store
Persistent storage of data logged by the FactoryTalk Diagnostics
subsystem. In a distributed system, these logs can reside local to the
machine. When diagnostic data is retrieved, all information from
diagnostic logs within a system can be merged. There is no implied
implementation or format of diagnostic logs in this specification.

Diagnostics message
Diagnostics information furnished by a diagnostic client with
self-describing internal structure and content.

Dynamic unit allocation
The process of binding a specific unit to a class-based unit procedure
or operation. Dynamic unit allocation can be defined only at the
procedural level.

Dynamic HTML elements
Elements, such as text areas, buttons, etc., that are used for user
interaction, or ele\-ments in which one or more event handlers are
defined. For example:
<IMG src=./images/Earl.JPG>
would not be a dynamic element, but
<IMG src=./images/Earl.JPG onclick=’msgbox "Kaboooooom!"’'>
would be a dynamic element. Clicking on it displays a message box
containing the text "Kaboooooom!".

Electronic signature
An electronic representation of a signature, including all associated
data. Can consist of one or two signoffs. Associated data includes
meanings for the signoffs, comments, security requirements, and
timestamps.

Equipment phase
An equipment phase is the S88 terminology for the equipment phase
and equipment phase interface. In FactoryTalk Batch, equipment
phases are configured in the FactoryTalk Batch Equipment Editor as
instances of the recipe phases. Equipment phases are bound to the
recipe at
runtime.
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FactoryTalk Asset Centre
Formerly RSMACC (Rockwell Software Maintenance Automation
Control Center).

Firing attribute
The Firing Attribute (formerly the Acquiring attribute) has nine legal
states, defined as follows:
"0": Not Firing - The transition is not in the firing process.
"1": Acquiring - The transition is in the process of acquiring resources
for the following steps.
"2": Binding - The transition is in the process of binding one or more of
the following steps.
"3": Committed - The transition is committed to the firing process, but
is not proceeding due to either a HELD state, or the parent procedure
being in MANUAL mode.
"4": Stopping - The transition is waiting for one or more prior steps to
achieve a terminal state after having been issued STOP commands.
"5": Resetting - The transition is waiting for one or more prior steps to
transition to IDLE after having been issued RESET commands.
"6": Pending - The transition is waiting for one or more prior steps to
transition into a legal state for a Transfer of Control operation.
"7": Paused - The transition is waiting for a RESUME command or a
return of the parent procedure to AUTO mode.

First Available binding
This is one of the ways that units are selected for binding. This is called
late unit binding or dynamic unit allocation. When automatically
selecting a unit for binding, the FactoryTalk Batch Server tries to use
the unit that the recipe can acquire first. The unit selected must meet
two criteria:
• The acquired unit must belong to the unit class of the unit
procedure step.
• Recipes can configure upstream and/or downstream dependencies
defining a series of unit classes that a recipe requires as a recipe
executes. The acquired unit supports the flow path to other units.

Formula
A category of recipe information that includes process inputs, process
parameters and process outputs.
36
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Formula value
A value that is assigned to a parameter defined for a specific step of a
phase, operation or unit procedure. A formula value may have a literal
value assigned to it or it may receive a value from the next higher
recipe level when the batch is run.

Initial step
The logical start of a sequential function chart (SFC).

Late binding
This is a binding method where a step is bound to equipment just
before it is used.
• For unit procedure steps, this is also called dynamic unit allocation.
Two types of late unit binding are supported: First Available and
Prompt binding.

Manual binding
Manual binding is the process an operator can use to select steps in a
control recipe and interactively bind them to equipment. This can be
performed before or during a recipe’s execution.

Mode
The manner in which the transition of sequential functions are carried
out within a procedural element and the accessibility for manipulating
the states (manually or by other control functions) of equipment.

Not Firing
Not Firing is a possible state of the Firing attribute of a transition.
When the transition is in the Not Firing state, it is not in the process of
firing and not committed to the firing process.

Parameter deviation
A parameter deviation exists when a parameter value is not within the
limits defined in the recipe.

Paused
Paused is a possible state of the Firing attribute of a transition. When
the transition is in the Paused state, its expression has evaluated to
TRUE and it is ready to fire. It is suspended the firing process due to
the parent procedure being in SEMI-AUTO mode. It is awaiting either
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a RESUME command or a transition of the parent procedure to AUTO
mode before continuing with the firing process.

Pending
Pending is a possible state of the Firing attribute of a transition. When
the transition is in the Pending state, it is waiting for one or more
prior steps to transition into a legal state for a Transfer of Control
operation.

Providers
System components that provide diagnostic information to the
FactoryTalk Diagnostics system. Providers can be FactoryTalk system
elements or applications such as the FactoryTalk Batch Equipment
Editor and FactoryTalk Batch Recipe Editor.

Reactivation number
Every active eProcedure control step is given a Reactivation Number. If
the step has never been reactivated, the value is 0. If the step has been
reactivated once, the value is 1, etc. The recipe path, step index, and
reactivation number form a unique identifier for a control step.

Recipe path
Every active eProcedure control step has a recipe path. It describes, to
the phase level, what part of the recipe the step is from.

Resetting
Resetting is a possible state of the Firing attribute of a transition.
When the transition is in the Resetting state, it has issued RESET
commands to the preceding steps and is waiting for them to transition
to IDLE states in response to the command.

SFC Validation
A function of the FactoryTalk Batch Recipe Editor, this error check
looks for "logic" errors in the SFC structure defined within a recipe.

Shared resource
A resource used in parallel by an unlimited number of steps at a time
inside a recipe structure.
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Signature event
A probable new event type for the event journals that records the
signatures and the comment entered for the verification signature.

Signature ID
A 32-bit unsigned integer that uniquely identifies a Signature Request
within the FactoryTalk Batch system.

Signature list
A list of pending signatures and their related commands, report
parameters, etc. maintained on the FactoryTalk Batch Server.

Signature list UI
User interface for accessing all types of signatures not associated with
eProcedure phases.

Signature template
A collection of all the data needed to define a signature - number of
signoffs, signoff meanings, signoff security requirements, and signoff
comment requirements. Signature templates will be defined centrally,
and are referred to whenever defining signature requirements.

Signature states
A signature can be in one of the following states: Incomplete (the
signature is still pending one or two signoffs), Complete (all signature
signoffs have been completed), Cancelled (a user has cancelled the
signature), or System Cancelled (the FactoryTalk Batch Server has
cancelled the signature).

Signoff
A component of an electronic signature in which a user enters his
username and password and optionally a comment. An electronic
signature can require one, two, or three signoffs.

Signoff meaning
A short phrase describing the meaning attached to a given signoff. For
example, "Done By" or "Checked By".

Static binding
A binding method where a step or set of steps is bound to equipment
when the recipe is built in the FactoryTalk Batch Recipe Editor
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(equipment bindings are specified in the master recipe). Material
phase steps are never statically bound.

Step index
Every active eProcedure control step has a step index. The step index
represents the position of the step within the phase, e.g. the first step
has a step index of 1, the second step has a step index of 2, etc.

Stopping
Stopping is a possible state of the Firing attribute of a transition.
When the transition is in the Stopping state, it has issued STOP
commands to one or more of the preceding steps and is waiting for
them to transition to terminal states.

System cancelled
A Signature is considered to be System Cancelled when the signature
is cancelled by FactoryTalk Batch Server logic instead of through
operator action.

Target Parameter
The target parameter is the recipe parameter used in calculating the
limit when the limit type is percent or value.

Terminal signature state
All signature states except Incomplete are terminal states - once the
signature is in any of those states it cannot change to any other state.

Viewing context
eProcedure users can define a viewing context for the instructions they
view. The viewing context defines the set of equipment or recipes for
which they are shown instructions. For example, a user can view
instructions for a given unit, for an entire area, or for a specific
operation.

40

Publication# BWEPRO-GR011E-EN-P - May 2022

Index
step verification 30

Index
A
Archiver 13

B
Batch Server 11
starting in demo mode 22
stopping 22
Batch View 11
BATCHCTL 15
boot
cold 22
warm 22
warm-all 22

C
cold boot 22
eProcedure Server 22
configuring
sample demonstrations 15

D
demo mode
starting the Batch Server 22

E
eProcedure
introduction 9
eProcedure Server 14
Equipment Editor 13

F
FactoryTalk Batch components 9

G
glossary 33

I
instruction files
step verification template 30

O
OPC (OLE for Process Control)
communication protocol 24
opening
simulator demonstration file 24

P
phase logic simulation 24
Phase Simulator 24
starting 24

R
rebuilding
recipe directory 21
recipe
execution 10
maintenance 10
recipe directory
rebuilding 21
recipe maintenance and execution
simplify 10

S
sample demonstrations 15
servers
Batch Server 11
eProcedure 14
signature template 30
simulator 24
opening sample demonstration files 24
starting
Phase Simulator 24
stopping
Batch Server 22

V
View 11

W
warm all boot 22
warm boot 22
eProcedure Server 22
removes reactivated steps 26
Windows Service Manager 22

M
MS Word
Publication# BWEPRO-GR011E-EN-P - May 2022

41

Rockwell Automation support
Use these resources to access support information.
Technical Support Center

rok.auto/support

Knowledgebase
Local Technical Support Phone Numbers

Find help with how-to videos, FAQs, chat, user forums, and product notification
updates.
Access Knowledgebase articles.
Locate the telephone number for your country.

Literature Library
Product Compatibility and Download Center
(PCDC)

Find installation instructions, manuals, brochures, and technical data publications.
Get help determining how products interact, check features and capabilities, and find
associated firmware.

rok.auto/literature
rok.auto/pcdc

rok.auto/knowledgebase
rok.auto/phonesupport

Documentation feedback
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at
rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)
At the end of life, this equipment should be collected separately from any unsorted municipal waste.
Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.
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